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The users of the RC213V-S data logger are eligible for email support in ENGLISH, GERMAN, or 

JAPANESE at the following address: RC213V-S@2d-datarecording.com 

Symbols used in the text 

 
These paragraphs contain tips and practical advice for working with the 2D system 

 

In the paragraphs highlighted with this symbol, you will find additional information and it is 

very important that you follow the instructions given. 

 

Documentation reference  

 A user manual reference number is provided so the user can seek further assistance 
 

mailto:RC213V-S@2d-datarecording.com
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1 System requirements 

 Operating system: Windows Vista, 7, 8, 8.1, 10, each 32bit and 64bit versions 

 Processor: Pentium or higher 

 Clock frequency: 1GHz or higher 

 RAM: 1GB 

 Graphics: min VGA 800*600; recommended: 1920*1080; best: 2 monitors with 1920*1080 

 Graphics adapter: any adapter with sufficient resolution 

 USB 2.0 
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2 Data recording with the USB Stick Logger 

This section will guide you through the essential steps for setting up the USB Stick Logger for a first 

recording. It is explained how to download the recorded data to your PC and how to visualize them with 

the 2D analysis software. 

First of all install the 2D software as described in the manual “Software installation”.1 The RC213V-S 

software will be licensed as a kit software automatically. It is needed for adapting the setting of the USB 

stick logger, downloading recorded data from the USB stick to the PC and for analyzing the recorded 

data. 

The following section describes how to configure the software and the USB Stick Logger for a recording. 

2.1 My first recording 

There are some actions you only have to do once on a racing event: 

 To record data onto a USB stick, the USB stick has to be prepared. The USB stick which is included 

in your data logging package is already prepared. Otherwise refer to section 4 on how to prepare 

one. In the following such a prepared USB stick is called “2D stick”. 

 After the installation the software uses an event with demo data. You can´t download data into the 

demo event. Therefore you have to create a new event.   

Events and master names help you organizing your data. Every time you change the location (race 

track) you create a new event. When you´re downloading the data you only have to select a master 

name. Refer to section 3 on further information about events and master names and on how to 

create events. 

 In section 2.2 you find a description on how to adapt the setting of your logger. It starts with finding 

out the current setting of your logger and ends with starting the analysis for your first recording.  

As the logger is programmed for plug & play it is normally not necessary to change the setting. 

2.2 Configuring the USB Stick Logger using a USB stick 

The most common way to set up the USB Stick Logger is via USB stick itself.  

 

The first step is to find out how your USB Stick Logger is configured. For that you simply connect the 

2D stick to your logger. Turn the logger on2. Now the USB Stick Logger will store its current configuration 

in the file default.ldd onto the 2D stick. When the blue LED is blinking you can unplug the 2D stick. 

The 2D software contains a program called WinIt. With that program you can visualize the configuration 

information. To do so start the program WinARace and connect your 2D stick to the PC.  

 

The software is preconfigured to search for recorded data on a 2D stick when WinARace 

is running. If recorded data is available, it is downloaded automatically and 2D Analyzer 

starts.  

 

                                                   
1 The manual can be downloaded from: 2d-datarecording.com/en/support/downloads/manuals ⇒ Software installation 
2 When the logger is connected to your bike: turn on the ignition. 

http://2d-datarecording.com/en/support/downloads/manuals
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Click on the button <Communication (F2)> to start WinIt or press the function button <F2> on your 

keyboard. 

 

In the menu “File” select “Load device from file” and open the file default.ldd from your 2D stick. As the 

USB Stick Logger has a fixed setting for the Honda RC213V-S you are only able to rename your logger 

and store new GPS lap trigger information to your setting within WinIt. Confirm your changes with 

<Apply>. 

For transferring the changed setting to your USB Stick Logger save it as setup.ldd on your 2D stick 

(“File” ⇒ “Save device in file”). 

Connect the 2D stick with your prepared set-up to your USB Stick Logger and turn the USB Stick Logger 

on. Every time you connect a USB stick to the logger it searches for files starting with “setup” and 

updates itself. During this process the LED shines continuous blue. After the logger has completed the 

setup procedure it renames the file setup.ldd to setu!.ldd on the 2D stick and writes information about 

the result of the setup procedure in the file setup.txt.  

Make your recording. For that the 2D stick has to be connected to the logger! 

Start WinARace and make sure the correct event is chosen. Select a master name to identify more 

easily the session (free practice, qualifying, race, test, etc.).  

Unplug the 2D stick from your logger and connect it to your PC. The recorded data will now be 

downloaded automatically to your PC and the 2D Analyzer will open the data and present them for 

analysis. 

2.2.1 How to change the logger name 

The logger name is part of the measurement´s file name. Therefore it is very useful to change the logger 

name.  

1. Start WinIt and load the default.ldd-file. 

2. Select your logger-setting in the system tree. 

3. Right click and choose “Rename”.  

4. Enter your logger´s name. The last 4 characters of your 

logger name are part of the measurement´s file name! 

5. Confirm your changes with <Apply> and save the 

setting on your stick (“File” ⇒ “Save device in file”) as 

setup.ldd. 

 

2.2.2 How to change the lap trigger table 

There are two reasons to change the lap trigger table: 

 You downloaded a newer version of the lap trigger table from the 2D website3. 

 You modified the existing lap trigger table with your own lap trigger positions. 

Please refer to the manual “GPS Laptiming” 4, section “Creating or modifying a start-line”, on 

how to do this. 

                                                   
3 The table can be downloaded from: 2d-datarecording.com/en/support/downloads/servicepacks/ ⇒ GPS laptrigger position 

table. Store the downloaded GPS lap table in the common table directory, for example:   

C:\ProgramData\Race_RC213V-S\System\Tables 
4 The manual can be downloaded from: 2d-datarecording.com/en/support/downloads/manuals ⇒ Generate laptimes with GPS 

http://2d-datarecording.com/en/support/downloads/servicepacks
http://2d-datarecording.com/en/support/downloads/manuals
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Please follow the step by step instructions to change the lap trigger table inside the logger: 

1. Start WinIt and load the default.ldd-file. 

2. Select tab “Send tables” and push “Send laptrigger position table (2DTrkPos)”. The software 

then automatically inserts the current 2DTrkPos-table into the setting. 

 

3. Save the setting on your stick (“File” ⇒ “Save device in file”) as setup.ldd. 

2.2.3 How to change the lap trigger settings 

You have different options to change the settings of the lap trigger.  

The “Radius” is used to define the area around the entered coordinates to trigger the signal. Please 

refer to the manual “GPS Laptiming”4, section “Automatic setting of LapGps”, on recommended values. 

If the bike is slower than the minimum speed when it is within the radius of the GPS lap trigger (for 

example during the pre-start procedure of a race), it will not set a lap time. These two values (radius and 

minimum speed) are taken into consideration each time a lap time is triggered (independent of automatic 

or manual lap trigger entry).  

If the favored lap trigger coordinates are not stored inside the lap trigger table, you can manually set 

them in two ways:  

 Insert the values into the corresponding fields.  

 Click on <Read from line file>.  

Line files are created with the Analyzer. Please refer to the manual “GPS Laptiming”4, section 

“Creating or modifying a start-line”, on how to do this. 

To get to the settings please follow the step by step instructions: 

1. Start WinIt and load the default.ldd-file. 

2. Select tab “Laptrigger coordinates”. There you can enter the previous mentioned settings like 

lap trigger coordinates, radius and minimum speed. 

 

3. Confirm your changes with <Apply> and save the setting on your stick (“File” ⇒ “Save device 

in file”) as setup.ldd. 

 

The RC213V-S data logger is not able to record GPS sections.  
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3 Working with the software 

3.1 WinARace 

WinARace, the front-end program started on the desktop, shows the following levels: 

 

 

a.) Event/measurement 

administration 

b.) Communication 

c.) Measurement naming  

d.) Measurement 

selection & analysis 

 

a) Within the event/measurement administration you have three different options: 

1. The drop-down list contains the last used events. 

2. The button <…> to change to another existing event. 

3. The button <Create event> to create an event. Please refer to section 3.4 on how to do 

this. 

b) The <Communication (F2)> button is used to start the program WinIt.  

c) Please refer to section 3.3. There it is explained how the measurement is named. You can use 

the suggested master names or enter the name you want. 

d) Within the measurement selection and analysis you have four different options: 

1. The drop-down list contains the last selected measurements for analysis. 

2. The button <Newest> selects the last downloaded measurement of that event. 

3. The button <…> to select another measurement of that event. 

4. The button <Analysis (F3)> to start the 2D Analyzer. 

3.2 General data structure of measurement data 

All measurement data are stored in the RaceData folder (e.g. C:\RaceData). In this folder you can find 

your events. Every single event contains information about the particular racetrack and the 

measurement data. 

 
   Data directory 

    

Event directories     

    

    Measurement (*.MES directory) 

3.3 Measurement nomenclature (master names) 

The measurement´s name consists of three parts – the master name, (part of) the logger name and the 

number of download.  

 

For example: 
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1QP-CS-01.MES  ⇒ master name: 1QP-____- (qualifying 1)  

     logger name: CS  

     number of download: 01 (first download) 

TST-DP26-03.MES  ⇒ master name: TST-____-  

     logger name: DP26  

     number of download: 03 (third download) 

1126-MM93-05.MES  ⇒ master name: DATE-____- (date of data download, e.g. 26.11.) 

     logger name: MM93  

     number of download: 05 (fifth download) 

RACE-3V-S-01.MES  ⇒ master name: RACE-____- (4 underscores)  

     logger name: RC213V-S  

     number of download: 01 (first download) 

RACE-RC213V-S-02.MES ⇒ master name: RACE-________- (8 underscores)  

     logger name: RC213V-S  

     number of download: 02 (second download) 

Some of the standard master names are: 

 DATE-___- (current date information) 

 TST-___- (Test) 

 1FP-___- (Free Practice 1) 

 1QP-___- (Qualifying 1) 

 WU-___- (Warm Up) 

 RACE-___- (Race) 

“DATE-___-” is a special master name. It is used to create measurement names containing information 

about the date when the measurement was downloaded. The software replaces the part “DATE” of the 

master name by the month and day at which the measurement was created. The format is MMDD, which 

means the first two characters are replaced by the month and the next two by the day. 

The underscores ( _ ) are replaced by the logger name. Therefore the number of them specifies how 

many characters of the logger´s name are taken to create the file name. 

3.4 Create a new event directory 

 

The first and most important step before downloading the first measurement is to create 

an “event”. Always start with this step, so that you always know where your data has been 

saved! 

From the image below, the current directory is shown on the left hand side. This defines where data will 

be saved or from where measurements are read. 

 

On the right side there are two options: 

1. You can switch to the “event module” by clicking on the button < … >. There you can also select 

events which are not contained in the drop-down list (last used events). 

2. <Create Event> will set up a new directory with the option to select the track used at that event. 

To create an event follow the next steps: 
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a) Click <Create event> to open the following window. 

 

b) Select on the right-hand side if it is a closed circuit or not (marked in red). 

c) Select a racetrack if it is a closed circuit (marked in blue). If a track is not listed, select <Click 

here if circuit is not in list> and a basic circuit will be selected (Base.ren). 

d) The standard-name of the events is the current date combined with the name of the selected 

track. But you can change its name in the field “Eventname” (marked in green) 

e) Confirm your event with <OK> 
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4 How to prepare USB sticks 

 

The USB stick which came with the package is recommended.   

But any USB stick can be used. A USB 3.0 compliant stick can be used as well. 

2D uses a unique method to write data onto the USB stick. Before using a USB stick for the first time, it 

has to be prepared. Such a prepared USB stick is called a “2D stick”. Only this ensures that all data are 

saved and the file system is not corrupted even if the 2D stick is removed from the logging device while 

recording.  

The USB stick will be formatted with the specific 2D file system based on FAT32. The maximum size of 

a stick is limited only by the FAT32 file system (up to 2 TB). Some USB sticks may not be fast enough 

for storing all data during recordings, especially if a lot of channels with high sampling rates are recorded. 

No general recommendation for a specific USB stick type can be given. Suitability of a certain USB stick 

can only be asserted by testing. 

To prepare a USB stick start the program WinARace and connect it to your PC. Open the Modules-

menu and select Prepare USB stick for usage in a 2D USB Stick Logger5 or push the toolbar icon: 

 

 

The following window appears: 

 

In the first drop down box the drive letter has to be chosen where the USB stick is accessible. If the USB 

stick is connected while the program is running the correct drive letter is selected automatically. The 

program allows formatting of USB sticks only. If the USB stick you want to use is not recognized as a 

removable disk, please rename it to “2D-STICK”.  

The next input field specifies the default size of the measurement files. 2D recommends 256 MB as 

default file size (1-2047 MB are possible sizes).6  

In the third box the total number of files needs to be specified.7 

You can use the given default values (256 MB file size, as many files as possible) for the time being. If 

your application for the USB Stick Logger needs different parameters, section 4.2 explains how to 

calculate the right numbers for your case. 

Press <Format and prepare> to start the process. Make sure the file system FAT32 is selected. 

Choose <Quick Format> and press <Start>.  

Please be aware that this process may take a while! 

                                                   
5 WinARace can be configured to hide the menu bar - the menu is also available via right mouse-click. 
6 Please refer to section 4.2 for a description on how to define a file size and number for your requirements. 
7 The program reserves some space (512 MB) for small programs or calculation files on the stick.  

Rule of thumb: <nbr of files> * <file size> + 512 MB ≤ <size of stick>  

Example: 13 files * 256 MB + 512 MB≤ 4 GB stick  
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After the USB stick is formatted close the format box. After that, a bar graph shows the progress of 

writing the files on the stick. Depending on number of files and file size this takes some time. 

 

The following message indicates that the USB stick can be removed from the computer and is ready for 

use. 

 

4.1 Transfer of recorded data 

This section describes what will happen if the software detects a 2D stick. 

 

Make sure the correct event and master name are set in WinARace before plugging in the 

2D stick into the computer for data transfer. For further information on event and master 

names refer to section 3. 

The software is preconfigured to search for recorded data on a 2D stick when WinARace is running. 

When this situation occurs and a 2D stick is detected, it is automatically checked by the software whether 

the 2D stick contains the folder named 2D-Datarecording. If such a folder exists, the software checks if 

the folder contains files with recorded data. If such files are found they are copied into the selected event 

directory. After this the analysis software 2D Analyzer starts for further processing the copied files. Once 

the data is transferred to the PC, they are automatically deleted from the 2D stick and the 2D stick is 

prepared for the next recording. This will be indicated by a message to the user. 

If you get a warning like the following one, then one or more of the files on the 2D Stick may not be 

written continuously while preparing the stick. As the USB Stick Logger is not able to use those files it 

will skip them. Please prepare your 2D Stick again. 
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If the download does not start automatically you have the option to start the download process manually: 

⇒ WinARace ⇒ Modules ⇒ 2D USB Stick Handler 

 

4.2 Computing the number and default size of measurement files 

For measurements with a lot of data it may happen that a single measurement run does not fit into a 

single file on the stick. The data will then be split into several files. (It may happen that several seconds 

of data may be lost until the second file is opened for recording.) 

If you want to avoid such situations, you can adjust the number and size of the measurement files when 

preparing the stick with the 2D file system. 

 

The minimum size requirements can be calculated from the current logger configuration.  

The expected data rate is not the only factor which has influence on the file size. In an ideal environment 

the USB Stick Logger is connected to two different kinds of power supply, a permanent 12 V one and 

the power on/off signal (switched power). When the logger is recording data and it detects the power 

down signal (ignition off) it still can write all recorded data to the 2D stick before powering down. On the 

next power on signal the logger will select the same data file if there is still space in the file. Otherwise 

it will select a new file. 

However, if there is no permanent power supply it may happen that the logger cannot write all recorded 

data to the 2D stick in case of power down. In such cases up to 4 kB of data recorded last may be lost. 

At the next power up the logger will select a new file when the next recording is started. The same may 

happen if the 2D stick is detached during a recording session. 

In normal operation conditions (both 12 V signals are connected) it is suggested to format the 2D stick 

with some big files because a total loss of power is very unlikely. 

In cases where the permanent power supply may be cut off (e.g. by disconnecting the battery) more 

small files (big enough to record a complete normal run) are the preferred choice when formatting the 

2D stick because recording continues with a new file once the power is available again. 

Example: Calculating the minimum file size for a measurement run  

The USB Stick Logger for the Honda RC213V-S has a data rate of 3906 byte/s. If a typical measurement 

takes around 45 minutes the minimum file size is calculated:  

𝟑𝟗𝟎𝟔 
𝒃𝒚𝒕𝒆

𝒔
∗ 𝟒𝟓 𝒎𝒊𝒏 ∗ 60 

𝑠

𝑚𝑖𝑛
= 10546200 𝑏𝑦𝑡𝑒 = 10.5 𝑀𝐵 

To store the measurement in one file, the minimum file size has to be greater than the calculated value. 



 

Race RC213V-S  page 13 / 23 

5 2D Analyzer 

5.1 Desktop view 

A typical Analyzer desktop consists primarily of these 4 windows: 

 The main menu and the toolbar are at the top. 

 

 The Overview window at the bottom is where you can view particular channel curves of the 

complete measurement. 

 

 The biggest window takes up the center of the screen and is called the Moving window. It shows 

details of all selected channels of the measurement. 

 

 The small Circuit window shows the current racing circuit (created from GPS signal or selected 

from predefined circuits) and tells you which section is currently selected in the Moving window. 

It is not shown at default, but it is available via “Function” ⇒ “Circuit” or shortcut <C>. 
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 In addition of the “standard” windows described above, it is possible to define specific views 

onto measurement data8. “Corners”, for example, is a selectable view of the track: 

 

5.1.1 Main menu items 

 The File menu contains functions, including those loading and modifying 2D measurement files. 

 The Functions menu provides access to the basic and advanced analysis functions. 

 The View menu controls the desktop layout of Analyzer. 

 The Measurement menu enables you to change the way in which measurement data are 

displayed. 

 The Settings menu contains functions for program administration and settings for race events. 

 The Wizards menu launches a program for analyzing cornering sectors. 

 The Help menu takes you to general help contexts. 

 

The menu functions may differ depending on your license-level and the used modules to 

measure data. 

                                                   
8 There are some different views programmed in this software version. To define specific views a higher license level is needed. 
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5.1.1.1 The main menu item “File” 

 
 Load measurement of event: Open 2D explorer; load measurements of the same event. 

 Load measurement: Open 2D explorer 

 Overlay lap: List of lap times in the current measurement. Possibility of loading another lap and 

comparing it with the current lap (lap overlay) 

 Remove active measurement: If more than one measurement is loaded, you can remove the 

active measurement 

 Exchange measurement: Replace the active measurement with another measurement 

selected with the 2D explorer. 

 GoogleEarth™ link: View measurement data in GoogleEarth™. 

 Store GAP table of current lap: Creates a GAP table you can use in 2D dashboards. 

 Export: Export of data into two formats, first csv-format for dash ware, second 2D format. 

 Screen export: Export all visible channels from the current section and compress them in a ZIP 

archive file. 

 Restore original lap times: Reset the lap times to “as logged”. All manual changes to any lap 

triggers are removed. 

 Comment: Add a measurement-specific comment to the SpecSheet file belonging to this 

measurement. 

 0-9: History list: View and select from a list of the 10 most recently loaded measurements. 

 Exit: Exit the analysis program. 
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5.1.1.2 The main menu item “Functions” 

 

 Laps: Window with the lap times of the measurements currently loaded. 

 Section times: Section times of the active measurement. 

 Circuit: Window showing the circuit and the active section. 

 Multi circuit: Race lines of all measurements mapped onto GoogleMaps™ images, zoom 

functions. 

 Track mode9: Detailed view of the circuit showing certain sensor values in corners or on 

straights. 

 XY-Plot9: Lets you define a 2-dimensional graphic plot of the relationship between two selected 

channels. 

 Min/max table9: Lap-by-lap list of minimum, maximum and average values. 

 Histogram9: The measured-value statistics for a channel. 

 GPS: Definition of a starting line for lap generation. 

 Print report manager: Function for printing the screen views. 

 Measurements: Editor for channel settings. 

 Active measurement: Define one of the measurements currently loaded as the active 

measurement. 

 Run AutoCalc: Recalculate the virtual Calc channels. 

 Screenshot: Paste a screenshot of the current desktop to the clipboard. 

                                                   
9 To define own views you may need a higher license level. 
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5.1.1.3 The main menu item “View” 

 

 Quick bar: Hide/ show the function bar at the right edge of the screen. 

 Windows full screen: Full-size view of the moving and overview window. 

 Reset window positions: Reset to the last defined window position. 

 Templates: select from different stored templates. 

 White background scheme: Set white as the background color. 

 Light background scheme: Set grey as the background color. 

 Dark background scheme: Set black as the background color 

5.1.1.4 The main menu item “Measurement” 

 

 Linked: Two or more loaded measurements are moved in synch in the Moving window. 

 Measure: Start/ stop measuring mode. In measuring mode the channel values at the mouse-

pointer position are shown as readings. 

 Distance plot: View channel transients plotted over distance (in meters). 

 Time plot: View channel transients plotted over time. 

 Previous selection: Show the preceding selection in the Moving window. 

 Zoom full lap: The current lap is shown in its entirety in the Moving window. 

 Jump to lap start: Shift the moving section to the start of the current lap. 

 Previous lap: Jump to the preceding lap. 

 Next lap: Jump to the next lap. 

 Jump to fastest lap: Move selection to the fastest lap in this measurement. 

 Synchronize: Synchronize all loaded measurements with the active measurement so that all 

measurements can be compared at a given lap position. 
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5.1.1.5 The main menu item “Settings” 

 

 Language: Choice of 6 different languages: German, English, French, Italian, Spanish, 

Japanese. 

 Speed channel: Define the channel used to calculate the distance from speed. 

 Track: Circuit settings, e.g. type and length. 

 Printer setup: Options for the printer currently selected. 

5.1.1.6 The main menu item “Wizards” 

 

 Create track map: Creates a track map out of GPS or acceleration signals. 

 Detect track segments: Corners/straights on the circuit are detected on the basis of log data. 

 Tire perimeter: Used to enter the tire perimeter – not necessary with the Honda RC213V-S. 

 Lap checker (auto mode): Lap trigger checking and correction wizard. 

5.1.1.7 The main menu item “Help” 

 

 Help: Context help. 

 Shortcut keys: List of all keyboard shortcuts (hotkeys) in the Analyzer program. 

 Show hints: Show comments close to the mouse-pointer position in certain windows. 

 Glossary 

 FAQ: Frequently asked questions. 

 2D-Datarecording-Homepage: Starts your web browser and opens the 2D homepage. 

 Mail to 2D-Datarecording: Starts your mail program to send an e-mail to mail@2d-

datarecording.com. 

 About: Information about your 2D software. 
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5.1.2 The toolbar buttons  

5.1.2.1 File functions 

 

 
Loads another measurement: Open 2D explorer 

 
Loads another lap of active measurement: List of lap times in the current measurement. 

Possibility of loading another lap and comparing it with the current lap (lap overlay) 

 
Removes active measurement 

 
Replaces active measurement: Replace the active measurement with another measurement 

selected with the 2D Explorer. 

5.1.2.2 Basic Analyzer functions 

 

 
Overview: View the Overview window for the active measurement. 

 Moving: View/activate the Moving window. 

 Laps: Window with the lap times of the measurements currently loaded. 

 Multi circuit: Window showing the circuit and the active section. 

5.1.2.3 Advanced Analyzer functions 

 

 
Track mode: Detailed view of the circuit showing certain sensor values in corners or on 

straights. 

 
XY plot: 2-dimensional graphic plot of the relationship between two selected channels. 

 
Min/max table: Lap-by-lap list of minimum, maximum and average values. 

 
Histogram: The measured-value statistics for a channel. 

5.1.2.4 Visibility of channels 

 

 Channels: Editor for channel settings. 

 
Groups: Particular channels can be grouped. 

5.1.2.5 Additional functions 

 

 Quick bar: Hide/ show the function bar at the right edge of the screen. 
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5.1.2.6 Templates 

 

 Templates: Select a desktop layout. 

5.1.2.7 Measurement functions 

 

 
Linked: Two or more loaded measurements are moved in synch in the Moving window. 

 
Measure: Start/ stop measuring mode. In measuring mode the channel values at the mouse-

pointer position are shown as readings. 

 
Distance plot: View channel transients plotted over distance (in meters). 

 Time plot: View channel transients plotted over time. 

 Previous selection: Show the preceding selection in the Moving window. 

 
Zoom full lap: The current lap is shown in its entirety in the Moving window. 

 Jump to fastest lap: Move selection to the fastest lap in this measurement. 

 Previous lap: Jump to the preceding lap. 

 
Next lap: Jump to the next lap. 

 
Synchronize: Synchronize all loaded measurements with the active measurement so that all 

measurements can be compared at a given lap position. 

5.2 Program modules 

5.2.1 Overview window 

Quick overview of the entire measurement. 

Each measurement opened in the 2D Analyzer module is shown in a separate Overview window. The 

measured data of selected channels are graphed in the Overview window. The timing triggers for the 

lap times are shown accordingly. This provides a speedy overview of possible problems affecting the 

motorcycle or the logger. 

A grey rectangle in the Overview window indicates the position corresponding to the details shown in 

the Section window. 

5.2.2 Moving window 

Enables precise comparison between individual measurements with the added benefit of a survey 

option. 

The measurements opened in the Analyzer are all shown together in the Section window. Unlike an 

overview window, which shows the entire measurement, this window shows only a selected part of the 

measurement. This permits precision overlay of measurements so that the curves can be compared. 

 

A rectangle in the overview window indicates the position corresponding to the details 

shown in this window. 
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5.2.2.1 Measurement mode 

A special Analyzer mode in which the physical values corresponding to the current position of the mouse 

pointer are shown in a separate small measured-values window. 

Press <space bar> or double-click to start measurement mode, <space bar>, <ESC> or double-click 

to end. 

You can use all the Analyzer functions in measurement mode. For example you can resize the section, 

load a different measurement or remove a measurement. 

The measured-values window shows the measured physical values for a channel that correspond to the 

current position of the mouse pointer. 

 

This measured-values window shows either the measured values of all visible (activated) channels or 

all available channels. You can toggle between the two modes by clicking on the small black double 

arrow. This double arrow is in the header of the left column of the measured-values window. 

Double-click on a channel to hide or show the channel. 

 

If you left-click on a measured value (not on the channel name) in the measured-values 

window and hold the mouse button down, the corresponding channel starts flashing in the 

Moving window. This makes it easier to identify the channel, particularly if you have loaded 

a number of measurements and have numerous channels visible for each. 

5.2.3 Channels 

In the Analyzer tool, each sensor that transmits measured values to the data logger is represented by a 

channel. A measurement consists of multiple channels. In addition, virtual channels are computed. 

 

Each channel has its own individual settings and users can change these settings. 

Numerous functions assist you in administrating channels. You also have the option of 

grouping certain channels. 

You access channel administration through the main menu, the toolbar or the <ALT> + <U> keyboard 

shortcut. 
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5.2.3.1 Channel administration 

 

Column Meaning 

Visible Channel visible in the moving window 

Scaling Scaling visible10 

Overview Channel visible in Overview window 

Lower limit / Upper limit Physical lower and upper limits of the display 

Color Individual channel color 

Reduce Type of data reduction in the Overview window10 

All All measured values are bands in the Moving window10 

Key Shortcut for hiding/ showing channel10 

Hz Frequency of channel10 

Start Channel membership of the “Start” group 

Ruler/ Alarm Show a horizontal grid line10 
 

5.2.3.2 Channel properties 

You open the editor for channel properties by clicking on the upper limit or lower limit column in channel 

administration. 

 

                                                   
10 Cannot be changed in this software version. 
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5.2.4 Lap times 

Table of all lap times across all the measurements now loaded. 

The first page shows a list of all lap times for all the measurements currently loaded. Each of these 

measurements has its own page with details of lap length in meters, plus start and end of lap. 

 

Invalid lap times are highlighted in light grey. This always applies if lap length does not match track 

length, as is the case with out-laps and in-laps on the circuit. 

 

Manually inserted laps are underscored. 

If you click on a value in the table the corresponding lap is shown directly in the Moving window. The 

section in the Overview window changes accordingly. 

5.2.5 Section times 

Table of all sections times of a particular measurement 

 

Overview of the section times for the track as defined beforehand, lap by lap for all the 

measurements currently loaded. The sum of the best section times is the ideal lap time. 

 

 

 


